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June  Meeting Info


…. Mike Murray


Date:  Tuesday, June 16, 2007


Time:  7:00PM


Location: Mike Murray’s home. 777 East Main Street, Williamsburg, OH 45176. BRING YOUR OWN STEAK KNIVES! 


Phone:  (513) 724-7777


Directions:  Take I-275 to the Rt. 32 exit. Travel east on Rt. 32 for about 15 miles. Turn right onto Delepalma Rd. Turn left when Delepalma dead-ends into Main Street in Williamsburg. Mike’s place is about ½ mile on the left (back a long driveway.).


Food:  This is a steak cookout.


NOTICE: If you haven’t already done so… let Mike know you are coming… CALL MIKE ASAP. OR, THERE WILL NOT BE A STEAK FOR YOU.








Website Information


Queen City Chapter Web Site: � HYPERLINK "http://www.ncrs.org/qc/" ��http://www.ncrs.org/qc/�


Webmaster:   Jack Hunt   � HYPERLINK "mailto:jmhunt826@yahoo.com" ��jmhunt826@yahoo.com�








NHRA Car Show & Drag Race & Swap Meet June 19-21 in Bowling Green …DaleMaris#48325�











WHAT I HAVE LEARNED


…… The Indiana Playboy





There is much more to being a Playboy than meets the eye. Many of you may not know this, but you have to experience a lot to make this look as good as I do. For example… here is a short list of the many things I have learned.





If you want to succeed really bad, be prepared to fail first… because that is the first step to success.


We all have times in our lives when we fall; it’s what we do when we get back on our feet that counts.


Sometimes ignorance truly is bliss and if you do not want to know the truth, don’t ask the question.


We don’t have to change friends if we understand that friends change.


Never be too eager to find out a secret. It could change your life forever.


A good friend is better than a therapist.





Now a few more that are of more immediate usefulness:





If you can’t be kind at least have the decency to be vague.


Birthdays are good for you. The more you have the longer you live.


The second mouse gets the cheese.


If you think there is good in everybody, you haven’t met everybody.


The sole purpose of a child’s middle name is so he can tell when he is really in trouble.


When you put the two words “The” and “IRS” together it spells “Theirs”.





And here is one I heard in Church:





A five year old was standing next to me and here is what I heard:





“Our Father, Who does art in heaven, Harold is His name. Amen.”




















































































































Using Styles in This Template


To change the Style of any paragraph, select the text by positioning your cursor anywhere in the paragraph. Select a Style from the drop-down Style list at the top-left of your screen. Press Enter to accept your choice.


�


See Page 4 to learn how to edit or replace this picture.


The styles available in this template allow you to change the look of your headlines and other text. The following is a list of some common styles and their uses.


Body Text - Use this style for the regular text of an article.


Byline - Use this style for the name of the author of an article.


Byline Company - Use this style to type the author’s company.


Sidebar Head - Use this style to type a second-level heading in a sidebar article.


Sidebar Subhead - Use this style to type a third-level heading in a sidebar article.


Sidebar Text - Use this style to type the text in a sidebar article.


Sidebar Title - Use this style to type first-level headings in a sidebar article.


Footer - Use this style to type the repeating text at the very bottom of each page.


Heading1 - Use this style to create headlines for each article.


Heading2 - Use this style to create section headings in an article.


Jump To and Jump From - Use these styles to indicate that an article continues on another page.


Mailing Address - Use this style in a mailing label to type the destination address.


Postage - Use this style in a mailing label to type postage information.


Return Address - Use this style in a mailing label to type your address.


Picture Caption - Use this style to type a description of a picture or illustration.


Subtitle - Use this style to type sub-headings in an article.


Use PullQuote to excerpt text from the main text of a story to draw a reader’s attention to the page. See page 4 for an example.


�





Chairman’s Message


……  Steve Hack 





Our annual "Chef Murray Steak Grille Out" will be on the 16th of June at Mike and Olivet’s house in Williamsburg.  If you plan to attend and you did not sign up at the May meeting you mush call him before June 10th to reserve a steak dinner.  (513-724-7777)


 


Our NCRS neighbors from Dayton are in heavy need of judges for their meet on the 20th of June.  Please give them a call and lend a judging hand.  Speaking of registering, let’s try to make Mr. Ballard’s job a little easier and register for our chapter meet early.  We have included a registration form in this newsletter.  


 


We are half way through 2009 and still receiving membership dues, if you have forgotten to pay please mail your check to Mike Croake ASAP so you can keep getting these informative and often comical newsletters.  


�At the last two meetings we have spoken about the available officer positions for the chapter.  We will be voting in November for the new officers now all we need are volunteers.  Keep this in mind, and if you have any questions on the duties of any position just speak up or give that officer a call.  I am sure with such a good group of volunteers we will not have a problem come November.


 


Don't forget to attend all of the car related activities that you can, because soon enough it will snow shoveling season!


 


See you all at Chef Murray's





****Save the dates****





Friday nights --  Milford Kroger cruise ins


Saturday nights -- New Richmond cruise ins (new beautiful location on the river)


Sunday nights -- Quaker Steak and Lube cruise ins  both locations!


Sunday Sept 27 -- QC family picnic @ Fernbank Park


Saturday Oct 10  -- QC Chapter Meet @ Columbia Chevrolet


 


Steve Hack


 





Upcoming QCNCRS Events





Jun 16th  QCNCRS Mike Murray’s Williamsburg, OH





Jun 20th  Saturday Miami Valley Meet





MAY 2009 QCNCRS MEETING


…..  Otto Takacs Jr.





Our May QCNCRS Meeting was held on May 19, hosted by Steve Hack and his family at their business Eastern Corvettes. Steve has a restoration shop specializing in Corvettes. They offer a lot of services from total frame off award winning restorations to repairs.  Steve and Mike can help with normal maintenance as well as any mechanical, electrical, suspension, interior or body work that your car requires. They have been very helpful in giving direction to many members and customers in determining what the best path to take to accomplish the class of car that they would like to have in the end. Along with a great meal and a very nice evening, special thanks to Gabe, Steve and Mike for everything.


Steve started our meeting by welcoming everyone who came and introducing new members to our club. We welcomed one new member; Dave Diedrichs. 





Steve talked about up coming events in our club and other Corvette events that are going on around the country. There is more information on these on the schedule of events page in our monthly news letter or see them on our web site.





We are having our election of board members in November of this year. To encourage interest, we are trying something that we have not done before. At our monthly meeting we are having board members talk about the positions that they hold and what is required to do that job. We are doing this so members will have a better idea of what a position requires and can ask any questions that they may have.  If you have been giving any thought to one of the positions and would like more information you can talk to the person holding that position or have your questions answered at our next meeting.   If you would like to run for one of the positions you can tell me (Otto) at one of the meetings or call me at 937-294-2179.





Mike Croake gave our membership report which was very positive.  If you have not paid your dues yet you can talk to Mike at one of our meetings. Please pay as soon as possible because we are getting ready to print our  new directory.





Wayne McKee gave our Treasurer's Report and it was approved by all of our members. Wayne reviewed the expenses and income and then answered any questions that members had.





Bruce Slattery would like to have a Road Trip this fall to French Lick. The trip would be in September or October.  If you would like to go you can talk to Bruce at one of our meetings.











  John Ballard gave an up date about our Regional Meet in 2010 and also would like members to sign up as soon as possible for our Chapter Meet coming up on October 10, at Columbia Chevrolet.  If you have any questions about either event you can talk to John at one of our meetings or call him at 502-426-2184.


   Jim Zimmer is recovering well from his operation for cancer; our prayers and thoughts are with him and we all hope to see him back soon.


Our June Meeting will be on June 16, at Mike and Olivet Murrary's home for our  annual steak cookout. If you have any questions or need directions you can call Mike at 513-724-7777.





                                           Secretary,


                                  Otto G. Takacs Jr.    


  


 


NOTE FROM MIKE HACK


…..  Mike Hack





Line X / Pro Audio hosted one of our meeting a few years back and they returned to set up a small display at our 2008 Swap Meet.  Matt Steins, the shop salesman, was very impressed with the turnout and plans to attend next year.  Matt is offering a $40 discount for spray in bed liners to our members; he can also help you with any accessory from remote starts and stereo systems to running boards and window tint.  Give Matt or Frank a call at 513-752-7500 to set up an appointment.  Several of our members have had great luck dealing with them.  Remember to tell them that you are a QC NCRS member!





MEMBERSHIP CHAIRMAN


…. Mike Croake





Once again, Mike and Olivet Murray are going to assemble an updated QCNCRS Membership Book. In order to be included, and continue to receive “The Side Draft”, you have to be a paid-up member as of April 30, 2009. If you have not paid your membership by this date you will be dropped from our roster,


See you at the next meeting,


Mike Croake


THE PARTY SOURCE


Mike,


 


Thanks for the interest, the NUB Cigar Event at the Beer Sellar in Newport will be on April 21st (Tuesday) from about 4:30pm/5pm until about 7pm. We would love to have anyone with a unique car to show up and display their ride. I have attached the promotional packet that was sent from the Cigar Company. Anyone that can show up would be great so pass along the information and they can contact me at the store (859)291-4007.


 


Thanks,


 


T.J. Christie


Fine Wine Buyer


The Party Source


95 Riviera Drive


Bellevue, KY 41073


� HYPERLINK "http://www.thepartysource.com/" \o "blocked::http://www.thepartysource.com/" �www.thepartysource.com�








































































































































































































 


    























































































































A good time was had by all. As always there was a lot of food… and as always… there was none left.

















     Our July QCNCRS meeting was held on July 20 and was hosted by Paul and  Leslie Oslansky at their home. It was a great evening and a Paul and Leslie did a wonderful job with the meal. Special thanks to the both of them.





       Kurt started our meeting by talking about two nice events that our club has had this summer so far. Kurt thanked Dana Banfield and his wife and Greg Steinmetz for a great road tour and Mike and Olivette Murray for our annual steak cookout. A lot of effort and work went into these events by these members and it was greatly appreciated by everyone.





      Kurt went over some of the details for the upcoming chapter meet at King's Island in September. All facilities and accommodations are taken care of with the people at King's Island and we will be going over all of the positions that need to be filled to put on the meet at our next meeting. Volunteers are needed for a variety of things so please let Kurt know if you are  able to help.





    The planning and work that has been done on the  Regional Meet that we are having next year is going very well. We have some very nice pledges from the following companies so far. They include Eastern Corvettes,  Keen Parts, Trim Parts,  Eagle Products and Auto Zone. We have more sponsors that we are currently talking with and all members are encouraged to help with getting additional sponsors. If you would like to help with contacting possible sponsors or know someone who would like to be a sponsor you can contact Jim Dumont and talk with him. His phone number is .513-761-9593.





    Bob Burkhart gave our treasurer's report and everything is fine. Bob would like all members who are coming to the Chapter Meet to register as soon as possible and you can do this at our meetings or call Bob at 513-777-5952. He also has hats and T-shirts for sale and is talking to members to see if there is enough interest in getting new club shirts.





    Jim Dumont is checking the signs that we use at our Chapter Meet . If any signs need to be repaired or new ones made and you would like to help with this please talk to Jim at one of our meetings.





    Matt Stansbury gave our membership report and we are doing great. We have around 150 members so far and people still joining. Matt gave an update on what is going on at the Corvette Museum and things that we can help with. For members who would rather read the Side Draft on the web site and not want a hard copy mailed to them. please let Matt know and he will take care of everything for you.





    Steve Hack and Phil Schott will be doing the tech session on Friday evening September 24 at our Chapter Meet. Not only are they members of our club but they have achieved a very nice goal: they are both Bloomington Gold Senior Work Shop Instructors.  We are very happy for them for their accomplishments and glad to have them in our club.





   The guest speaker at our July  meeting, Dave Lombardo, does photo memories. Dave will take a picture of your car or you can send one to him and he will print it on something that you would like, such as a shirt, coffee mug, or maybe a mouse pad. Dave's company is Photo Memories, 16541 S. Broadway, P.O. Box 235, Moores Hill Indiana. His phone number is 812-744-1129.





          Our August meeting will be on August 17, and will be held at Jim Dumont's home. Jim's address is 226 Worthington Avenue, Cincinnati, Oh. If you need directions, Jim's phone number is 513-761-9593.


                                       Secretary,


                                  Otto G. Takacs Jr.�











Shouldn’t Have Said That!


…… Dave Schwoeppe





I liked the last newsletter that had a few funny things that people have said when their mouth got open before the thought about what they were saying. But


Then there are children. A few days ago I was in line at the bank where I do business and was standing behind a lady with a little 3 year old girl who was jumping all over the place.





She finally grabbed the toddler after receiving looks of disgust and annoyance from a lot of the other folks also in line. Very clearly I heard the women tell the little girl, “If you do not start behaving right now I will have to punish you.”





The little tyke stamped her foot, looked her mother in the eye and said very loudly, “If you do not let me go right now, I will tell Grandma that I saw you kissing Daddy’s pee-pee last night.”





The silence was immediate. I never saw a women move so fast in my life. The bank was filled with laughter well after I left.





How Smart Are You?


…… Bill Hengstebeck





You may not believe this, but I fish with a lot of very intelligent people. Just to prove my point… see if you can get a few of these questions correct: Which of the following are true or false?





Apples, not caffeine, are more efficient at waking you up in the morning.





People do not get sick from cold weather, it’s from being indoors a lot more.





Alfred Hitchcock did not have a bellybutton.





A pack-a-day smoker will lose approximately 2 teeth every ten years.





Seven per cent of the population are lefties.





40 people are sent to the hospital for dog bites every minute.





40,000 Americans are injured by toilets each year.





The first Harley Davidson motorcycle built in 1903 used a tomato can for a carburetor.





A coat hanger is 44 inches long when straightened.





Babies are born without knee caps. They do not appear until they are 2-6 years old.





Sooo… how well do you think you did? My fishermen buddies got 10 right. Did you?  Be honest. The answer is on the next page:























































































































































































































, Jr.


Update from Dana Banfield...    Details are coming together for the first 


annual Q. C. Chapter Spring Road Tour. Time to take off those winter covers , 


fill up those ' vettes with Sunoco 260 , and head south .The date is set for 


Saturday June  5th  2004. The route will take us thru some great scenic back 


roads in central Kentucky.  The destination .... Gayla Driving Center in 


Georgetown , KY.    Gayla is a Carriage Horse  farm , managed by me and my wife Debbi .


                                                                          re-elected as treasurer for our chapter. 





Our fall Chapter Meet will be held on September 18, 2004 at King's Island. We are starting to make plans for the meet and will have more details in the upcoming months.





Our web site is up and running and you can visit it at ncrs.org/qc. Jim Kammerer, Jack Hunt and Dana Banfield will be taking care of the web site for our chapter.


 


We have a new form available for our members to fill out at our meetings. It is to update our files for phone numbers and e-mail addresses. Be sure to fill one out as soon as possible. Also, Dave Schwoeppe made a new Survey and Profile questionaire for all members to fill out. The survey will address the concerns members have and any suggestions for improving things we do at our chapter.





Kurt filled out our annual chapter report and sent all information to the national NCRS. We accomplished everything required by the national NCRS board and received the Chapter of the Year award. John Adamson is in charge of this project for our chapter. If you have any questions you can talk to him at our meetings.





Paul  Oslansky has worked with Roy Sinor and we now have a poster showing the number of judging points each member has. Paul will bring the poster to our meetings and will keep it updated. If you do not see all your points, ask Paul.





Matt Stansbury is collecting membership dues for 2004. They are $ 20.00 and you can pay Matt at the meetings or send the money to his home. Matt's address is 3675 Rackacres Drive, Cincinnati,Ohio 45211.





Bob Burkhart gave the Treasurer's report and everything is fine. Our chapter made a donation to the Shriner's Burns Hospital this year and Bob also has t-shirts and hats for sale.





Carl Plummer is taking orders for jackets and also has Lusso Wax products for sale. You can talk to him at the meetings or call him. His home phone number is 513-563-5547.





Paul Oslansky's wife is a special education teacher and she would like to have any of your gently used or new car posters that you do not need. Leslie uses them to reward her students and they are greatly appreciated. You can bring them to the meetings and give them to Paul. However, Jim Dumont would like any of your old Snap-On Calendars.





 John Ballard is going to have a judging session for our chapter on Saturday April 17, at Classic Restoration in Louisville,Ky. Mike Murray is checking on possibly arranging a bus for all of us to ride down to Louisville. We will have more information at our next meeting.





Our March meeting will be a joint meeting with the Fort Thomas Corvette Club on March 9, 2004 at Tom Gill Chevrolet in Florence KY.  Mike Murray suggested that we change our June cook-out meeting to a Sunday afternoon instead of Tuesday evening and that wives/guests be invited.  The date is still pending.





Our February meeting will be on February 17,at Trim Parts.Inc. They are located at 2175 Deerfield Road, Lebanon,Ohio. The time will be 7;00. Their phone number is 513-934-0815





Secretary,


 Otto G. Takacs Jr. 





Special Notices:


…… Matt Stansbury





QCNCRS dues ($20.00) are due January 1, 2004. As always I am interested that everyone gets them to me as early in January as you can. You can either see me at any of our upcoming meetings or send them to me at:


Matt Stansbury


3675 Rackacres Drive


Cincinnati, OH 45211





International Marketing


…… Dave Schwoeppe


I have a few friends who work in International business and they were telling me some really interesting stories about what some companies have done to themselves because 


they


I always thought sign language was just for people with hearing problems, but my normal hearing neighbors have moved it into genuine entertainment.  I am still laughing.


Alan, age 10: LOVE AND MARRIAGE


You got to find someone who likes the same stuff. Like, if you like sports, she should like it that you like sports, and she should keep the chips and dip coming.


Lynnette, age 8: WHAT DO MOST PEOPLE DO ON A DATE?


Dates are for having fun, and people should use them to get to know each other. Even boys have something to say if you listen long enough.


Kevin, age 8: HOW WOULD THE WORLD BE DIFFERENT IF PEOPLE DIDN’T GET MARRIED?


There sure would be a lot of kids to explain, wouldn’t there? 


Pam, age 7: WHEN IS IT OKAY TO KISS SOMEONE?


When they are rich.


Kids listen to the adults around them and they reflect what they hear … it just comes out a little different.


onhis is the first time I have written a story for our newsletter, so I hope what I have to tell will make you laugh the same as it did me.


I don’t know how many of you know of my past affiliation with the Air Force, but it gave me many interesting stories about people… children especially.  Here is one that still makes me laugh, all though I heard it years ago. 


It was late at night and Heidi, who was expecting her second child, was home alone with her 3 year old daughter, Katelyn. When Heidi started to go into labor she called 911.


Due to a power outage at the time, only one paramedic responded to the call. The house was very, very dark, so the paramedic asked Katelyn to hold a flashlight high over her mommy so he could see while he helped deliver the baby. Very diligently, Katelyn did as she was asked. Heidi pushed and pushed, and after a little while, Connor was born.


The paramedic lifted him by his feet, and spanked him on the bottom. Connor began to cry. The paramedic then thanked Katelyn for her help and asked the wide-eyed 3-year-old Katelyn what she thought about what she had just witnessed.


Katelyn quickly responded, “He shouldn’t have crawled in there in the first place. Spank him again!”








 “Oh,” replied the wife. “Well, did you offer the man anything to drink?”


“Umm, no, I didn’t,” said the farmer. The wife then said, “I’m going to take something out there for him to drink.” The wife went to the cellar, got a bottle of wine, and then went out to the barn.


She didn’t return for over an hour, and when she did, her clothes were also messed-up, and she had straw twisted into her blond hair. She went straight up the stairs and into bed.





  





The January meeting will be at The Car Barn instead of  Montgomery Inn Convention Center. The meeting will also be moved to the 4th Tuesday, January 25th.  We thought the $2,000.00 Montgomery Inn wanted to host our event was WAY TOO MUCH!


November Meeting Minutes


……  Allen Braga


Host:  Jeff Barnhardt at Restoration Station


Tim Mickey, Chapter Chairman, opened the meeting at 7:55 PM.


Tim held an election of officers for 2000 and 2001. The following positions were up for re-election with all candidates “running” unopposed. Needless to say, these are the people who were elected:


Secretary:   Allen Braga


Membership Chairman:  Matt Stansbury


Judging Chairpersons:  Dave & Marilyn Heitzman


Road Tour Chairman:  Dan McDonough


Tim reminded everyone that dues for 2000 are due by next month.


Matt Stansbury talked about what he has in mind as Membership Chairman.


Publish the new Membership Directory in January. That is why he would like everyone to have his/her dues in on time.


Have special QCNCRS decals created.


QCNCRS business cards with membership information on the back. We can give these to anyone with interest in joining the chapter.


QCNCRS referral incentive of $10.00 dues rebate for new member referral (limit two rebates per member!)


Tim then discussed the following:


2000 QCNCRS Chapter Meet:


The Harley Dealer being built at Kings Island doesn’t look like it will interfere with our Chapter Meet.


He signed an agreement with K.I. for 2000.


Items to purchase:


A number of possibilities were discussed and people were asked for additional suggestions.


It was decided to table any decisions to  until January.


It was also decided to include a ballot on this subject in a future newsletter.


Tim received a letter from the NCRS Financial Director, Ken James, requesting a financial report be sent for this year’s Regional Meet. Tim and Bob Burkhardt will finalize the results and send them.


Bob Burkhardt:  Treasurer’s Report


Beginning Balance:		$8016.75


Receipts:			$  61.00


Expenditures:		$ 700.50


Ending Balance:		$7377.25


Bob reported our Regional Meet had cleared $4603.26 to-date with $500.00 still to be sent to Shriner’s Burns Institute.








includehaeach referralPossibleThis document was created using linked text boxes, which allow articles to flow continuously across pages. For example, this article continues on page two, while the one to the right continues on page three. When you add lines of words to a text box, the words in the following text box flows forward. When you delete lines of words from a text box, the words in the next text box moves backward. You can link several text boxes in an article, and you can have multiple articles in a document. The links do not have to occur in a forward direction.


Inserting Linked Text Boxes


To insert linked text boxes in a document, click Text Box on the Insert menu. Click and drag in your document where you want to insert the first text box, and insert additional text boxes where you want the text to flow.


To select the first text box, move the pointer over the border of the text box until the pointer becomes a four-headed arrow and then click the border. Click the right mouse button, click Create Text Box Link and then click in the text box where you want the text to flow. Repeat these steps to create links to additional text boxes.
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Formatting Text Boxes


You can change the look of linked text boxes by using color, shading, borders, and other formatting. Select the text box you want to format and then double click its border to open the Format Text Box dialog box. If you want to change the color or borders on a text box, choose the Colors and Lines tab. To change the size, scale, or rotation, click the Size tab. To change the position of the text box on the page, click the Position Tab.  If you have other text surrounding the text box, and want to change the way the text wraps around it, click the Wrapping tab. If you want to format all the text boxes in an article, you must format them individually - the formatting on one text box will not apply to the others in the sequence. 


Using Linked Text for Parallel Articles


You can use linked text boxes to flow text in parallel  “columns” from page to page. This method gives different results than using the Column command on the Format menu, which causes text in column 1 to flow or “snake” to column 2 on the same page. By using linked text boxes, you can instead have text from column 1 flow to column 1 on the next page. The text beside it in column 2 can flow to column 2 on the next page, parallel to column 1. This technique is useful if you need to group two similar articles, for instance, an article translated in English on the left and the same article translated in French on the right. 


To flow text in parallel, display paragraph marks in your document. Click at the top of the page where you want the side-by-side columns to start, and press Enter twice. Click in the first paragraph mark on the page. On the Insert menu, click Text Box and drag on the page where you want the first column. Click Text Box again and then click and drag where you want the second column. Click in the last paragraph mark on the page, and press Ctrl + Enter to create a page break.


Repeat the process for each page that will contain side-by-side columns in your document and then return to the first text box you created. Click the text box on the left once to select it. Click your right mouse button and then click Create Text Box Link. The pointer becomes a pitcher. Click the text box on the left side of the second page to create a link. Create links for all text boxes within the same article on the left side of the document. Repeat the process for every text box in the right chain or article.


Pressing Enter twice at the top of each page will create an extra empty paragraph. This blank paragraph is useful if you want to insert text or graphics outside of the text boxes. You can delete the extra blank paragraph if you don't need it.


Copying linked text boxes


You can copy an article or a chain of text boxes that are linked together, to another document or to another location in the same document. To copy linked text boxes and the text they contain, you must copy all the linked text boxes in an article. Select the first text box in an article. Hold down Shift, and click each additional text boxes you want to copy. On the Edit menu, click Copy. Click where you want to copy the text boxes and then click Paste.


To copy some of the text from  an article, select the text you want to copy from the article and then copy it. Do not select the text box. You can paste text you’ve copied directly into your document, into another location within the same article, or into another article.(

























































































John Ballard gave an up date about our Regional Meet in 2010 and also would like members to sign up as soon as possible for our Chapter Meet coming up on October 10, at Columbia Chevrolet.  If you have any questions about either event you can talk to John at one of our meetings or call him at 502-426-2184.





Jim Zimmer is recovering well from his operation for cancer; our prayers and thoughts are with him and we all hope to see him back soon.





Our June Meeting will be on June 16, at Mike and Olivet Murrary's home for our  annual steak cookout. If you have any questions or need directions you can call Mike at 513-724-7777.


                            


 Secretary, 


 Otto G. Takacs Jr.  
























































        


 6.2 D The Vice President shall automatically be appointed to the position of President when the position is vacated by the sitting President for the remainder of the previous president’s term. 








5.6 REVISED





Any vacancy in Officers, Managers, or Editors shall be filled by appointment by the President for the remainder of the term, with the exception in the vacancy in the office of the President which will be automatically filled by the Vice President, as stated in 6.2d.  This appointment to the office of President shall be for the remainder of the current term.  Any person appointed must be an active member.








The NCRS Foundation Mission statement was adopted:





Formed in 2006, the NCRS Foundation is a 501(c)(3) Charity designed to provide individuals and/or corporate sponsors an avenue to make charitable contributions of monies, stock/securities and/or Corvette archive memorabilia to support the NCRS Charity program. 





In addition the Foundation 2007 Milestone and Target Dates were announced.          





The next board meeting will be held in Marlborough, MA, on Friday, July 27, 2007, following the National Convention.


 


If you have any questions about the Board Meeting, please contact me.  


 


Keep on Vett'n!!


 


Marilyn Heitzman


Region II Director


�
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Staight-axle and mid-year cars have no circuit protection in the main power feed (main ignition wiring harness) from the starter to the rest of the car. A short circuit could result in a fried wiring harness and maybe a fire. To avoid this, remove the main wire from the starter terminal (don’t forget to disconnect the battery), cut off the end and install a GM fusible link which comes with a terminal connector on one end. The fusible link should be sized two numbers larger than the existing feed wire. For example, if the feed circuit is 14 gauge, a 16 gauge fusible link should be installed. This will insure that the fusible link fries before the wiring circuit does. Another  tip for straight- axle cars is to install a 1-amp fuse in the clock feed to avoid frying the rewind coil. If the battery gets low, there may be enough power to close the clock points, but not enough to open them, which results in the coil heating up and burning out.





The next morning at sunrise, the man in the barn got up and continued on his journey, waving to the farmer as he left the farm and walked toward the mountain. A while later, the daughter woke up and came rushing downstairs. She went right out to the barn, only to find it empty. She went to her father and said, “Where’s the man from the barn?”


Father answered, “He left several minutes ago.”


“What?”, she cried. “He left without saying good-bye? After all we had together? I mean, last night he made such passionate love to me.”


“What?”, shouted the father. The farmer ran into the yard looking for the man, but by now the man was halfway up the side of the mountain. The farmer screamed up at him, “I’m gonna get you! You had sex with my daughter.”


The man looked back down from the mountainside, cupped his hands next to his mouth, and yelled out ………….


ILAIDTHEOLDLADEETOO..  And that’s the true origin of yodeling … honest.




















Free GM Restoration Packet


… Reprinted from Northern CA NCRS 


For merely the asking, GM will send you a restoration package for your Corvette or Chevrolet vehicle.. FREE! When you call, request a restoration package for your model year vehicle. Be prepared to give them your Corvette’s (Chevy) serial number as well as the model.


Ask for a “Restoration Package” (it’s free in the USA). The restoration package they send includes complete engineering specifications for your year model, and also a very long list of parts vendors.


The USA Restoration Pack will NOT give you specific information for your individual vehicle, but generic info for the





Season’s greetings from your newly elected Membership Chairman. I want to remind everyone who have not sent in their $20.00 dues to please send them to me ASAP. I’m going to make-up the directory and have it ready for January 2000. I announced at the Nov. meeting that any current member who signs-up a new member gets $10..00 off his/her membership dues (two maximum). Remember the new Sportsman Class and invite a friend who might think their car doesn’t fit in with our group. This is an excellent program to get more people and Corvettes involved. If you have any questions or ideas concerning membership please contact me at: 513-662-1886. Have a Safe & Happy Holiday!


Best,  Matt


Humor and Other Useless Information


……  No One We Know!


A FEW USELESS FACTS


A duck’s quack doesn’t echo, and no one knows why.


Camel’s milk does not curdle.


In every episode of Seinfeld there is a Superman somewhere.


Cat’s urine glows under a black light.


MORE TEXAS BUMPER STICKERS


The early bird may get the worm, but the second mouse gets the cheese.


Jesus loves you… everyone else thinks you are an asshole.


Keep honking, I’m reloading.


Cover me, I’m changing lanes.


If you smoke after sex, you are doing it too fast!
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QCNCRS  OFFICERS





Chairman:	  Steve Hack (513)553-2080


		  2110 Beech Cove


		  New Richmond, OH 45157-8661


		  steve@easterncorvettes.com 


V. Chairman:     Dave Schwoeppe (513)661-5019


		  3729 Boomer Road


		  Cincinnati, OH 45247-8017


		  aplusinc@fuse.net


Judging:	  John Ballard (502) 426-2184


		 10102 Kimblewick Drive


		  Louisville, KY 40223-2184


		  john.ballard@burgesspigment.com


Secretary:	  Otto Takacs, Jr. (937)294-2179


		  4331 Overland Trail


		  Dayton, OH 45429-1835


		  genevagear@sbcglobal.net


Treasurer:	  Dr. Wayne McKee


		  10737 Wellerwoods Drive


		  Cincinnati, OH 45242-3406


		  


Membership:	  Mike Croake (513) 683-2734


		  734 Oskamp Drive


		  Loveland, OH 45140


		  mfcroakesr@hotmail.com


Historian:	  Don Budke, Jr.


		  1524 Teakwood Avenue


		  Cincinnati, OH 45224-2157


		  Buds42277@aol.com


Editor:		  Rod Russell


		  7742 Twelve Oaks Drive


		  Cincinnati, OH 45255


		   � HYPERLINK "mailto:rrrussell@fuse.net" ��rrrussell@fuse.net�
































QCNCRS Annual Judged Meet


Saturday October 10, 2009


Columbia Chevrolet
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